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Excel’s Layout and essential tools 

Excel is a spreadsheet program. A spreadsheet is a method of collecting and displaying 

information in rows and columns. Here are some essential parts of the Excel screen. 

 

• At the top of the screen is Excel’s Title Bar. 

• At the far left side of the Title bar is the Quick Access Toolbar. This toolbar can be 

customized, but comes with these four basic buttons: 

o At the far left is a Save button. 

o Next to that is an Undo button. 

o Next to that is a Redo button. (Redo undoes an undo that you regret.) 

o The last one is a Customize Quick Access Toolbar button. 

o Saving, undoing and redoing are all quite familiar to computer users. But you may 

never have customized the Quick Access Toolbar before. Clicking that small little 

down arrow will take you into a screen where you can pick and choose what lives up 

in that area. BUT – here’s an easier way! 

1. Find a button that you use frequently. 

2. Point your mouse and Right-Click on it. A list of options will appear. 

3. Left click on Add to Quick Access Toolbar and that button will now appear for your 

ease of use any time. 

4. If you have any regrets about placing this button up there, just point at it on the Quick 

Access Toolbar, Right-click on it and select Remove from Quick Access Toolbar. 
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• To the right of the Quick Access Toolbar is the file name title area. 

• At the right end of the Title bar are Excel’s resizing and Close buttons. These include 

Maximize, Minimize, Restore and Close as found in 95% of Windows programs. 

• Below the title bar is Excel’s Command Ribbon. The ribbon is segmented by Tabs, and 

the tabs are divided into Groups. Each group contains related command Buttons. This is 

very similar to the way the MS Word ribbon is configured. 

• As with the Word ribbon groups, some have a small diagonal arrow in the lower right 

corner that can be used to open a dialog box for you to access all of the possible commands 

for that topic. 

• Below the ribbon is a long horizontal stretch of buttons and work/display area. It looks like 

this: 

 

• On the left is the Name Box. This box tells you the address of your current location, the 

combination of a column letter and a row number. You can use this box to jump to another 

area if you know the exact address. Just type it in and tap the Enter key on your keyboard. 

• The next two buttons are Cancel and Enter. These stay greyed out until you are actually 

typing. If you are entering or editing data, they become “alive” and usable. The Cancel 

button is like tapping the Esc key on your keyboard. It aborts and edit or an entry. The 

Enter button is just like tapping the Enter key on your keyboard, except that you do not 

move down to the next row. 

• Next comes the fx button, officially called the Insert Function button. This is discussed 

in detail later. 

• Next comes the Formula Bar. This is a critical area of your screen. The Formula Bar 

displays cell content. That is not necessarily what is shown in the spreadsheet below. In the 

spreadsheet you see results. In the formula bar you see what was typed to achieve those 

results. The common need for this is when you must fix a malfunctioning calculation. If you 

see a wrong result on your spreadsheet, click on it. Then look up at the Formula Bar to see 

what was typed to get that result. Typing in the Formula Bar is one way that  you can edit 

cell content. You would: 

o Click on the cell. 

o Click in the Formula Bar to get a cursor. 

o Make the edit. 

o Tap your Enter key on the keyboard or click the Enter checkmark button. 

• Below the Formula Bar is the spreadsheet itself which dominates the screen. In Excel is 

made up of a grid of 1,048,576 rows and 16,385 columns. The rows are numbered and the 

columns have letters to identify them. The areas where you see those letters and numbers 

are called row or column headers. For the columns the first letters progress as A-Z. Those 

are followed by AA, AB, AC, AD, etc. After that comes BA, BB, BC etc. The last column is 

lettered XFD. 
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• You can navigate around the spreadsheet in many ways. 

o Tapping Enter moves you down. 

o The Arrow keys on your keyboard move you in the direction of the arrow, one cell 

at a time. 

o The Tab key moves you horizontally to the right one cell at a time. 

o Use Shift-Tab to move horizontally to the left once cell at a time. 

o The Home key on the keyboard will jump you to the left of the spreadsheet. 

o Ctrl-Home will jump you to the upper-left of the spreadsheet, which is usually A1. 

o Ctrl-End will usually move you to the lower-right corner of your data. But it doesn’t 

always work just as you expect, so be sure to check around where you land when you 

do this. 

o You can use PgUp and PgDn to move in vertical screenfuls. 

o You can use the End key followed by an Arrow keys to move through unbroken 

columns or rows of data. OR – to move through empty columns or rows. Use this if 

you are ever tempted to delete a row or a column. Be sure it is truly empty and that 

you are not in danger of deleting unseen data somewhere off your screen. 

o The Excel screen has vertical and horizontal scroll bars that you can also use to 

navigate. But beware, just because you scroll to a location and can see it, you won’t 

actually be there until you click on it. 

o  

Excel Data 

All data entered into an Excel spreadsheet is either Text or a Value. All values are either 

Constant or Variable. Values may contain 0123456789 + - ( ) , / . $ % E e as 

acceptable keystrokes. Any other keystroke will force the entry to become text, and text has a 

zero value. 

By default, text is left aligned in the cell where you type it. Values are right aligned, like this: 

 

You can change this to any alignment you prefer, but this is what Excel will do if you don’t 

apply a different setting. 

A Constant value is any number that you type into a cell. It is considered constant because it 

will not change unless you return to that cell and replace or delete it. 
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A Variable value is a number that results from a calculation that references other data in the 

workbook. If the other data changes, the variable value will adjust to show a new result. 

Every time you press the Enter key on your keyboard, Excel recalculates all of the formulas on 

that spreadsheet, even if there are thousands of them! 

Entering Calculations 

Excel uses most of the same symbols as we use when we are writing a calculation with pencil 

and paper: 

 

We use an asterisk instead of an “x” for multiplying because there is a column X. Computer 

programmers figured out early on that using an “x” for multiplying caused problems for the 

computer to understand what we might want. 

It’s important to remember that all formulas must begin with an equal sign. If you forget to 

type that, Excel will simply enter the formula as if it were text and no calculation would occur. 

Excel follows the same calculation Order of Operations as we were taught in middle school. 

Calculations that have more than one thing happening perform the calculations from left to 

right using the order I have them listed above. So, for instance, in this calculation, 

=D4*B17^2-G15/K92+47 

The exponent would be figured first. Then the multiplication and division. Finally, the adding 

and subtracting would be done, all in five steps, like this: 

 

But, let’s say that you wanted the value in D4 to be multiplied by the value in B17 before the 

exponent was calculated. You would need to make that change with parenthesis, like this: 

=(D4*B17)^2-G15/K92+47 
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Entering Data 

To enter data into the spreadsheet, simply click on the cell where you wish it to be displayed. 

Type the entry and then use Enter or Tab to move to the next cell where you need to make 

another entry. The act of moving out of the cell will enter the data for you. 

When creating a formula, it is always best to use Cell References instead of plain numbers to 

do the calculation. If you don’t use a reference, the formula will not be variable. That means 

that it won’t adjust if the data gets changed. For instance, in this example, I’d like to calculate 

the tax at .0875 of the cost. 

 

I could type =12.99*.0875 

That would actually do the calculation for me. But if that cost figure ever got changed, I’d have 

to retype the formula. Too Much Work! Also, if I had 200 of rows of data, I’d like to be able to 

copy that formula down the Tax column instead of having to type it 199 more times. So, it 

would be much smarter for me to type the formula into the first Tax cell this way: 

=C4*.0875 

Doing it this way makes this a variable value. It’s now a formula that will look into that first 

cost cell as it calculates. 

If you are entering formulas that will be repeated across a row or 

down a column, you can have Excel fill in those repetitions for you 

instead of having to enter them all yourself. For instance, in this 

worksheet, all I have to do is create the first calculation at the top of 

the Tax column. Then I can have Excel copy it down for me. And 

because I used a reference instead of just the 12.99 number, Excel 

will adjust the reference for me on each row. So, C4 would be come 

C5 in the next cell down. And then C6, and then C7, etc. This is as 

huge time saver. And it helps to avoid you making possible typos if 

you type less! 
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The Fill Handle 

When copying across a row or down a column, you can use 

CTRL-C followed by CTRL-V. But that involves a few extra 

steps. Instead it is MUCH easier to rely on your new best friend 

called the Fill Handle. Here I have typed the formula into cell 

D4. Because that is where I am currently located, I see the result 

in the cell but the formula (cell content) in the Formula Bar up 

above. 

Do you notice the very small black square located at the lower 

right corner of the line surrounding the cell where I am? That is 

the Fill Handle. If you point directly at it, your mouse pointer 

should shift to look like a crosshair. You must be careful, because 

it’s easy to point at the border instead of the Fill Handle and the 

crosshair suddenly will have arrows on it. That’s a different tool. 

So make sure your pointer has no arrows at the tips. 

 

You want this: 

 

Not this: 

 

That second mouse pointer will move cell content, not copy it. If you have the correct crosshair, 

you can simply drag and drop the formula down the column or across a row, as needed. 
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Show Formulas 

Imagine that you are given an Excel file by a co-worker who asks you to help find mistakes. You 

open the file and see that some of the results are incorrect. So you’ll need to examine the 

formulas to find the mistake(s). But examining each formula by having to look up into the 

Formula Bar to see how that calculation was constructed could be very time consuming and 

tedious. Instead, Excel offers us a way to see all the formulas at once. 

For instance here’s a worksheet where a student had to find a change in revenue by comparing 

the total in cell B13 to the new value in cell B22. She had to subtract the B22 from B13. Then 

she could just copy the formula across row 23 to fill in her worksheet. However a coworker 

noticed that the numbers that show in row 23 don’t look right. 

Here’s the regular view of her worksheet: 
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A quick look with Review Formulas shows that she was subtracting from row 14, not row 13. 

So all she needed to do was fix the first formula in B23 and then copy that across the row using 

the Fill Handle. She entered =B14-B22 into cell B23 instead of =B13-B22. Then she copied 

that across the row producing incorrect results in row 23. 

 

Show Formulas is a toggle that can be turned on or off two ways: 

• Use CTRL-Accent on your keyboard. (Accent is located just below the Esc key.) 

• Or, click on the  Show Formulas button in the Formula Auditing group on the 

Formula tab of the ribbon. 
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Non-Contiguous Ranges 

Sometimes you may need to select two or more ranges of cells that are not all next to each 

other. Perhaps you need them for a chart. Perhaps you want to apply a font change to them all 

at once instead of having to do each group individually. Here’s how to make that selection: 

1. Select the first range. 

2. Press and hold down the CTRL key on your keyboard. 

3. Using your mouse select each additional range. 

4. Release the CTRL key. 

It’s very important to not start by holding down the CTRL key. Only do that after you have 

selected the first range. Then, do not let it go until you have all the ranges selected. 

Commonly Used Functions 

Excel has dozens of Functions. These are predesigned calculation tools for things that we 

often need. Functions always have a specific syntax. First comes the name of the function. It is 

then followed by a left parenthesis. Then may come one or more Arguments that Excel uses 

to determine how to perform the task you want. The last keystroke is a right parenthesis. If 

there is more than one argument, they are separated by commas. Some functions have no 

arguments at all. But they still must have parenthesis, even when empty. 

The most common function of all is the SUM function. We don’t normally subtract, multiply or 

divide long columns or rows of numbers. But we busy bee humans are always adding things up. 

Here’s an example of how it might look: 

=SUM(B2,B3,C9:C15) 

In this example, Excel would add together all of the values found in cells B2 and B3 and the 

range starting at C9 and ending at C15. (Ranges are always noted with a beginning cell 

address and an ending cell address separated by a colon.) 

You can type this into a cell where you wish to see the result, but Excel offers a button called 

AutoSum that will do this for you. The button is found in the Editing group on the Home 

tab of the ribbon. It usually looks like this: 

 

On some computers screen resolution can change how this looks so that you only see the 

symbol and don’t see the word. 

Notice that this button has a down-pointing triangle. That’s an indicator of an option list. If you 

click directly in the middle of the button, the SUM function will be presented in your cell. But if 

you click that option indicator, a list of other common functions like AVERAGE, MIN and 

MAX will be offered.  



 
 

Page 12 of 27 MS Excel Review Notes © Betsy Walker 2019 
 

When you insert a function in this manner using the button, you must never assume that 

Excel is calculating with the correct cell references. Depending on the layout of your data, Excel 

can very easily be wrong. When that happens, simply use your mouse to indicate the correct 

range before you tap Enter to finalize the formulas. 

The Insert Function Dialog Box 

Excel has a wonderful tool that helps you build functions. It is triggered with the fx button next 

to the Formula Bar that we mentioned earlier. When you click on this button an Insert 

Function dialog box will open up. It will look like this: 

 

In the Search for a function area at the top, you can type in a phrase telling Excel what you 

want to do. Then click the Go button. Excel will try to interpret your needs and then it will 

present possible functions in the Select a function list. 

Or, if you know that your task pertains to a certain kind of work, like working with text data or 

financial numbers or logical yes/no information, you can use the Or select a category 

option list to narrow things down to your pertinent area of need. As you can see the default 

setting for that section is Most Recently Used. 

The Select a function list shows the result of what you asked for. Excel will provide helpful 

information about whichever function is highlighted in that list. For instance, in this example 

the SUM function is highlighted. Below that in bold lettering, Excel displays the syntax that 

the function requires. Below that it gives you a definition of what the function can do for you. 
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Once you have highlighted the function you wish to use, click the OK button at the lower right 

corner of the window. A new step in the dialog sequence will appear, something like this: 

 

Here you will be presented with boxes to fill in any arguments required for completion of the 

function. The SUM function requires at least one cell or range of cells to be added up. You 

would type the first one in the first box, and if there are more, you’d click in the second box for 

the next one. Each time you add an argument for this function a new box will appear in case 

you need it. Many functions just have a set number of arguments and don’t provide those extra 

boxes. 

As you enter the argument details, Excel will let you know how things are going by giving you 

results along the way. For instance, if you typed B3:C9 into the first box, Excel would add up 

that range and show you that one results where you see the number indicator. All the 

arguments would be added up where it says formula results at the bottom left. This lets you 

keep an eye on how things are going as you construct the formula. 

Once you are done, click the OK button to complete the function and have it inserted into the 

cell where you started. If you keep an eye on your Formula Bar as you do this, you’ll see that 

Excel is providing all the keystrokes you need to have proper syntax. You provide the 

arguments and Excel does the rest. 

Formatting the Worksheet 

Excel let us apply many different styles and formatting choices to our worksheet. We can add 

color, change fonts, create borders, etc. to any portion of the sheet we wish to enhance. You will 

always need to begin by highlighting the cells you want to alter, then use the tools on ribbon to 

make your changes. Most of these are located on the Home tab. You’ll want to explore the 
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Font, Alignment and Styles groups for these. You can use skills that are already familiar to 

you from working in MS Word for many of these settings. Excel also offers some preset Styles 

accessed by clicking the Cell Styles button in the Styles group. 

You can apply these changes to text and/or numbers, as you need. 

Numeric Formatting 

Numbers have special formats that give us a visual clue as to their value. These formats are 

controlled through the  Number group on the Home tab. Here are examples of the effect of 

these formats, all applied to the same set of keystrokes, “1234.56”. 

 

Conditional Formatting 

Sometimes you may wish to enhance certain data in a conditional manner. That means that 

the style may change depending on the content of the cell or even of surrounding cells. For 

instance, in a financial worksheet, you may wish to have all of the losses be red, bold with a 

yellow background, like this. See how those numbers “pop” off the page? Because this was done 

with a conditional format, if the data changes, the format will adjust if necessary. 
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Or in a statistical worksheet, you may wish to have a column of numbers enhanced showing 

their relative values with colors and/or symbols. Here’s a list of baseball stats, showing the 

players standings compared to each other: 

 

To do this: 

1. Highlight the range of cells where you want to apply the conditional format. 

2. Click the Conditional Formatting button located in the Styles group of the Home tab. 

An option list will appear like this: 

 

3. You can peruse the first five options that are presets with the bold titles. I used an Icon Set 

for the baseball example. 
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4. Or you can click on the New Rule button to create your own rule. This will open another 

dialog box screen, with many tools to consider. It looks like this: 

 

5. For the financial example above, I did this: 

a. Click on Format only cells that contain. 

b. Click OK. 

c. The screen shifted like this: 

 

d. I changed the Between option to Less Than. 

e. I provided the value of zero to tell Excel to look for losses. 
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f. Then I clicked the Format button. It opens another dialog box that I could use to 

find the colors I wanted. It looks like this: 

 

g. I used the Font tab and the Fill tab to determine the red numbers on a yellow 

background. 

h. Then I clicked OK to finish the formatting portion. 

i. Then I clicked OK a last time to complete the operation. 

There are dozens of ways to use Conditional Formatting. You won’t want to overdo it with 

your co-workers. But it’s fun and can really enhance someone’s appreciation of your data. 

Charting the data 

Charts and graphs are presentation tools that you can use to help coworkers or other people 

understand and appreciate your data. There are some very simple steps to creating a chart, 

although it can get complex depending on what you want the final result to display. There are 

many formatting and style choices you can explore. But here are the basic steps to create a 

chart that you can then enhance. Here is a column chart that represents some income data: 
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Here are the steps used for this chart: 

1. Highlight the range providing the source of the data. This must always be your first step. In 

this case the user highlighted from A4:G10. This provided Excel with the values and also 

labels needed to complete the chart. Even though cell A4 is empty, it had to be included in 

order for all of the labels to be used. Notice that no totals or summary figures were 

included. You must never chart summary figures along with the data that makes up those 

summaries. It is not a sensible comparison. 

2. Click the Insert tab of the ribbon. 

3. In the Charts group, click the Column button. It looks like this: 

  

4. A list of column chart types will appear. Click on any one you’d like to try and it will appear 

on your worksheet. 

The good news about charts is that you cannot hurt your data when you make a chart. So if it’s 

a disaster, don’t worry. Just delete it and start over. 

While the chart is selected, two new contextual tabs will appear on the ribbon called 

Display and Format. You can use these to play with styles and color.  
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Absolute References 

When you type a formula into any cell, most of the references you make to other cells will be 
“Relative”. What that means is that if/when that formula is copied to any new location, the 

reference(s) in it will adjust relative to the new location on the worksheet, as in the payroll 

example below. In cell D4, the formula =B4*C4 was typed to obtain the gross pay amount for 

that one employee. Because the references to B4 and C4 are relative references, that formula 

can just be copied down the column for the remaining employees. Excel will adjust to multiply 

B5 times C5 for the gross pay in D5. It will figure B6 times C6 for the gross in D6, etc. This is 

a huge time saver. Without this feature, we would have to type every formula in column D 

manually and in a large payroll worksheet with hundreds or even thousands of employees that 
would cost us hours or even days of time. 
 

Here is what was typed in D4 with relative references and then copied down the 
column, adjusting in each new cell: 

 
 

The results: 

 
 

Sometimes, however, you do not want a cell reference to be relative. Sometimes you do not 

want it to adjust when/if a formula is copied. Consider this next formula we need for the 
payroll worksheet. Here we want to figure out the tax amount that will be withheld from each 
employee’s paycheck. But there is just one fixed point on the worksheet where that tax 

percentage is indicated, B11. (Having that fixed point allows us to easily change the tax 

percentage, as needed, without having to rewrite any formulas.) For the first employee we 

want to simply type =C4*B11. That will work easily for him. BUT, when we try to copy that 
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formula down the column for the remaining employees, we do not want the reference to B11 

to change. We want it to be absolute.  For our formula in E5, we do NOT want it to become 

C5 times B12. We want it to be C5 times B11. Then in E6 we want it to be C6 times B11, 

and so on down the column. 
 

We need to fill in column E: 

 
 

We do NOT want what you see in this next image. See how the relative reference to cell B11 

keeps changing? We don’t want that. We DO want the reference for D4 to be relative. We need 

it to become D5 and then D6, etc. But we need the reference to B11 to be absolute; it must not 

change when the formula is copied. 
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What we DO want: 

 
 

So that our results will be like this: 

 
 

Instead of this: 
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There are four different “states of relativity”. Here are their descriptions: 

 

Notation 
Example 

Name Description 

B11 Relative This reference, with no dollar signs, will adjust itself 
when used in a formula that gets copied to a new 
location on a worksheet. 

$B$11 Absolute This reference, with dollar signs, will NOT adjust itself 
when used in a formula that gets copied to a new 
location on a worksheet. Nothing will change. 

B$11 Mixed In this cell reference, with a dollar sign before the row 
reference, the column is relative but the row is absolute. 
So the column letter could change when the formula is 
copied, but the row reference will not change. 

$B11 Mixed In this reference, with a dollar sign before the column 
reference, the row is relative but the column is absolute. 
So the row number could change when the formula is 
copied, but the column reference will not change. 
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The IF Function 

We use the IF Function when we need excel to examine our data and make a choice before 

displaying results. 

The IF function’s syntax has three “arguments” separated by commas: 

=IF(Criteria Statement, display if true, display if false) 

Argument Description 

Criteria Statement • What you are looking for. 

• Tell Excel to analyze part of your worksheet by 

making a statement about it. 

• This statement must be either true or false. 

Display if True Tell Excel what to display if your criteria statement 

is true. 

Display if False Tell Excel what to display if your criteria statement 

is false. 

 

Here’s an example. I used an IF Function to tell me if each customer owed more than 

$15,000. If they do, they need new invoices.  
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Here are the three arguments I used: 

Argument: What I typed: 

Criteria Statement G4>15000 

Display if True “Yes” 

Display if False “No” 

  

So, my formula in cell H5 looked like this: 

=IF(G4>15000,”Yes”,”No”) 

• This looked at G4, where the new balance is for the first customer. 

• It determines whether or not that customer owes over $15,000. 

• It then tells the user whether or not they need a new invoice. 

• Copying this down the column analyzed for each customer. 

 

To make your life extra easy, don’t  type this yourself. Use the Insert Function Dialog Box 

to help you build the correct syntax! 

 

Calculating Across Multiple Worksheets 

Sometimes you may have a workbook that contains multiple worksheet of dat. It is then 

possible that a formula on one worksheet might need to read data on another sheet. There is a 

very specific syntax for this kind of formula. 

For instance, perhaps you have a business with an East Coast location and also a West Coast 

location. You might need a “Master” sheet that uses values from the East and West coast sheets 

to come up with a grand total. The East coast worksheet might have the number you need in 

cell C10. The West coast sheet might have the number you need in cell D10. 

To add up the numbers from those two cells into your “Master” sheet the formula would look 

like this: 

='East Coast'!C10+'West Coast'!D10 

There are a lot of very specific keystrokes in this formula. Notice that each worksheet tab name 

must be surrounded by single quotes. The name of the tab must be separated from the cell 

reference by an exclamation point. If you try to type this out manually, it’s very easy to have a 

typo and get it wrong. This is a time when it’s much easier to let your mouse help you in the 

process. Just follow these steps: 

1. Click into the cell on the Master sheet where you wish to see your result. 
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2. Type an equal sign. This sets Excel into calculate mode. 

3. Click your mouse on the worksheet table that you’ve called East Coast. 

4. Click your mouse onto cell C10 to grab the value from that cell. 

5. Type a plus sign to indicate addition. 

6. Click your mouse on the worksheet table that you’ve called West Coast. 

7. Click your mouse onto cell D10 to grab the value from that cell. 

8. Press the Enter key on your keyboard. 

Excel will return you to the Master sheet with the result displayed. The computer will have 

placed all the exclamation points and quotation marks where you need them so that you don’t 

have to worry about typing that out yourself. 

Dates are Values 

In order to be able to calculate with a date, it must actually be a value. Every day is a number to 

Excel. That way the computer can compute things like due dates. If you have an accounts 

receivable job, you’d need to know how long it’s been since invoices were sent out. That means 

the computer must count days. It can only do that if each day is a number. 

But … what number? What is today worth? What was yesterday’s value? How about tomorrow? 

It’s all a mystery to we mere mortals. 

Sometime in the past the folks who were developing computer systems made an arbitrary 

decision. January 1st, 1900 is equal to the number one. January 2nd, 1900 is equal to the 

number two. Every day that has elapsed since the 1/1/1900 is incremented by one. So today is 

the number of days that have passed since that date. Want to see it? Here’s how: 

1. Open a blank workbook and type 1/1/1900 into cell A1. 

2. Type 1/2/1900 into cell A2. 

3. Type the function =Today() into cell A3. That will input the current date. 

4. Type your own birthday into cell A4. 

5. Because you typed this information in a date format dd/mm/yyyy, Excel is displaying what 

you typed as legible dates. But let’s turn these dates into numbers. 

6. Highlight all four cells. 

7. In the Number group on the Home tab, it will be displaying the word Date. 

8. Change that to General. 

All the dates will turn into numbers. You will suddenly see how many days have passed since 

1/1/1900. You’ll also see how many days have passed from 1/1/1900 until the day you were 

born. Want to see how many days you’ve been alive? Type this formula into cell A5. 

=A3-A4 

There ya go! 

  



 
 

Page 26 of 27 MS Excel Review Notes © Betsy Walker 2019 
 

Navigating large worksheets 

When you have a really large worksheet with lots of data it is sometimes problematic when you 

scroll around because titles at the tops of columns or at the left of rows will scroll off the screen. 

The you are in dangers of making mistakes if you need to edit or enter data. 

Here’s a worksheet I found on Google. It is a police report with over 1,000 rows of data. The 

titles of each column are critical. Without those titles, I’d have no clue what each column 

meant. 

 

As soon as I start to scroll down, this happens: 

 

What’s the difference between columns J, K, M and N? Who could say? 
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The same issue arises if you scroll to view data on the right side. Immediately the Case 

Number is lost and there’s no way to know which case you are reviewing, like this: 

 

Column A has disappeared. With data looking like this, doing any kind of data editing or entry 

would be dangerous. 

But we can use a feature called Freeze Panes to help us out. That button is found in the 

Window group on the View tab of the ribbon. It offers us three options: 

• We can freeze all rows above our location and all columns to the left of our current location. 

• We can freeze row the top row (row 1). 

• We can freeze the first column (column A). 

In the above example, we’d wan to use the first option. If we begin by clicking into cell B2, that 

first option would freeze row 1 (above us) and also column A (to the left of us). Now it would 

not matter how far down or how far to the right you scrolled. You’d never lose the column titles 

or the case number. 

The next time you click that button, the first option will display as Unfreeze Panes. 

 


